AgentSheets Tutorial – Party Hat Chemistry

In the Party Hat Chemistry activity each student played the roll of a chemical substance undergoing a chemical reaction that was represented by putting on or taking off a hat. In this tutorial we will see how we can use a program called AgentSheets to build a model of this classroom activity on the computer. AgentSheets allows us to build a type of model referred to as an agent-based model. Agents are the individual objects in the model. Using the AgentSheets software, we create these agents and then assign rules for how those agents behave in our model. 

In order to model the Party Hat Chemistry activity we will need to create agents that have the following behaviors:

	Agent
	Behavior

	Student
	Roll die to determine whether to put-on hat, take-off hat, (raise hand) or do nothing.

	Data Recorder
	Tally the number of students of each type and add those data to a chart.

	Background
	Agent-based models usually include a background that just defines the extent of the model, and where the action takes place.


Step 1 – Start a new project and create the agents

From the File menu within AgentSheets select New Project. Go to the Desktop, or a directory where you keep your files and then give the project a name like “Party Hat Chemistry Model”. When you click OK in the New Project dialog box, AgentSheets opens a Define Agent Size dialog box, use the drop-down list to select a size. 32 x 32 agents are large, easy to see and can include some detail in their depictions, but, because they are large, not very many of them can be fit into a model worksheet. When small agents are used, many can be included, but the individual agents won’t have much character because they are small. For now, let’s use the default 32 x 32 agent size by just clicking OK.

Now your new project is open. In the top left area of the screen you should see the Gallery window. This is where you create and modify your agents. Lets create our three types of agents. At the bottom of the Gallery window click the New Agent button. Type in the name for the agent, in this case type “Student”, and hit OK. As you can see, AgentSheets gives new agents a face by default, this makes it straightforward to have agents that represent people. Click New Agent again to create the “Data_recorder” agent (you can’t have spaces in agent names, so use the underscore character instead). Finally, create the “Background” agent.

Now we have three types of agents that all look identical, (as seen in the image on the left below) so we need to change their appearances to make it easier to tell what they are, and what they are ding in the model. Since the student agent represents a person we can leave it as it is for now. Let’s start by changing the depiction of the “Background” agent. Click anywhere on the tab that contains the “Background” agent, the tab should now be highlighted by a light blue border (which can be hard to see) that tells you that this agent is selected. Now click the Edit Depiction button at the bottom of the Gallery window. This opens the Depiction window (on the right below), which allows you to edit the picture used to represent the agent pixel-by-pixel, or using some simple tools.
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At the bottom of the Depiction window click the Clear button. Near the top of the Depiction window, select a color to use as the background. I’ll use blue. The selected color will show up in the large colored square at the left side of the color palette. Now select the Fill Tool on the left side of the Depiction window, it is the one that looks like a bucket of paint being poured out. With the Fill Tool selected when you click in the depiction area the active color will fill any pixels that are the same color as the pixel you clicked on, and are contiguous with that pixel (share a side). Since we just cleared the depiction, all the pixels were empty, so when we click with the fill tool all the pixels should become blue (or whatever color is currently active). Now select a light color and then select the Draw Rectangle tool (the open rectangle, not the filled rectangle). In the depiction area we are going to click and drag from one corner to the opposite corner. When you release at the opposite corner you should see a light border around the entire depiction area. Click on the Done button.

Now edit the depiction for the “Data_recorder” agent. Make the “Data_recorder” agent active in the Gallery window and click Edit Depiction button. Since this agent will be taking measurements and plotting them you can create a depiction that represents that in some way, using the few pixels that you have. For example, use a number symbol “#” to represent the agent that is measuring and plotting numbers. First click the Clear button, then fill the background with a desired color, the lightest gray allows this agent to be distinguished from the background color and from empty space (which is white). Use the Fill Tool to fill the background for the depiction. Then select a dark color and use the Pencil Tool to draw your depiction. Click Done when you are finished.

Your model will look better if you match the background of the “Student” agent’s depiction to the color that you selected for your “Background” agent. Open the Depiction window for the “Student” agent and use the Fill Tool to change the background areas of this depiction to the same color that was used for the main area of the “Bakcground” agent. Then click Done. 

While we have a “Student” agent in the gallery, what about a student with a hat on or with a hand raised? These different types of students are represented in AgentSheets as different depictions of the “Student” agent. With the tab for the “Student” agent selected, click on the New Depiction button at the bottom of the Gallery. Give this new depiction a name like “Student_With_Hat” and click OK (again, use underscore characters in the name instead of spaces). The new depiction should appear just under the original depiction in the “Student” tab. Select the “Student_With_Hat” depiction and click on the Edit Depiction button at the bottom of the Gallery. Select a nice bright color and use the Pencil Tool to add a hat of your own design to this depiction, and click Done.
Now we need to add one more depiction of a student wearing a hat with their hand raised. To do this right-click (control-click on a Mac) on the “Student_With_Hat” depiction. In the pop-up menu that appears select Duplicate Depiction and then Same. Give this depiction a name like “Student_Hand_Up”. Edit the depiction so that it looks like the student has their hand up. The trickiest part of this is finding the skin color to draw a hand. You can either use the Color-Picker Tool, which looks like an eye-dropper and click on the face somewhere, or you can use the Color Chooser that is found on the Color menu. When you are done, the Gallery should now look something like the image on the left below.
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Step 2 – Create a worksheet

We will now create a worksheet that looks like the image on the right above. The worksheet is where we build the working model in AgentSheets. From the File menu select New Worksheet. This opens a new untitled worksheet. You can give yourself some more room by dragging the bottom right corner of the worksheet. In the Gallery window select the “Background” agent. In the Worksheet window select the Filled Rectangle Tool and click-and-drag an area filled with “Background” agents. 

Now select the “Student” agent in the Gallery. In the Worksheet window select the Pencil Tool. Place individual “Student” agents in the worksheet by clicking at desired locations (within the area that is filled with “Background” agents). Finally, you need to place one “Data_recorder” agent in the worksheet. Since the “Data_recorder” is observing the reaction simulation and not directly participating in it, this agent can be placed outside the area that is filled with “Background” agents. 

When finished, your worksheet should look something like the one in the image on the right. above. At this point you should save the worksheet. The project and gallery are saved automatically by AgentSheets as you work, but you need to tell AgentSheets when to save a worksheet. This is important, because whatever state the worksheet is in when you save it is the state that it will return to when you click the Reset button near the bottom right of the worksheet. 

Right now if you click the Run button, near the bottom left of the worksheet, the worksheet doesn’t change because the agents don’t have any behavioral rules telling them to do anything. After we have entered rules in the next step, running the model changes things in the worksheet. If we have saved the worksheet in the state that we want to start the simulation in, then all we have to do to prepare a new simulation is to hit the Reset button.

Step 3 – Add behaviors

As mentioned above, clicking on Run right now doesn’t seem to do anything. Since we haven’t created any behaviors for any of the agents, the lack of activity means our model is working (. Now we come to the core of the model building process: Turning the behavior of a system into a set of rules and instructions that the computer can follow so that the computer reproduces the behavior of the real system that we are modeling. Before trying to enter the rules into AgentSheets it is important to think about how the rules and behaviors that the components of the real system follow. In the Party Hat Chemistry classroom activity most of the actions are carried out by the students. Let’s list the things they do.

On a given turn a student:

· Checks to see if she or he need to do something given their state (hat off, hat on, hand up).

· Rolls a die to see if she or he will change state

· Change their state as determined by their roll

In AgentSheets, with the tab for the “Student” agent selected, click the Edit Behaviors button near the bottom of the Gallery. This opens the Behaviors window, as seen in the image below. 
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You will build rules and behaviors in AgentSheets using four areas in this window:

1. A Method is a set of rules that will be evaluated in response to a particular Trigger. In this case, “While running” is that the default Method that is evaluated on each turn, or time-step when the model is running. You should edit the text in the yellow box for each method describing what the rules in that method do in the model.

2. A Rule is a statement of the form “If  this is true, then do this.”

3. The Condition Box is where you place the conditions (“if this”) that must be true in order for the associated action to take place. If you double-click in this box AgentSheets will open the Conditions Palette (seen in the image on the left below), which contains examples of all of the conditions that AgentSheets can evaluate to see if it will carry out an action. Use the scroll bar to get to the bottom of the list. To add a Condition to the Condition Box just drag and drop it. You can customize any Condition by selecting from available options, or editing values within the Condition.

4. The Actions Box is where you place the actions (“do this”) of a Rule. It works just like the Conditions Box in that clicking inside it opens the Actions Palette (seen in the image on the left below), Actions are added by dragging and dropping, and each Action can be customized to your needs.

On each time-step AgentSheets goes through the rules for each agent. The program looks at conditions until it finds one that evaluates to “True” and it carries out the corresponding action. Any rules beneath the one that was carried out won’t even be looked at. If you need to have an agent take multiple actions on a time-step, then you will need to use messages to trigger additional methods containing rules that will be evaluated whenever an agent receives the message.

            [image: image6.jpg]


                            [image: image7.jpg]000 Actions:

messages
|0 oy ey |

(e (Webken) (Explan ) (Test]





We could write the rule for reaction #1 in the classroom activity as: 

· IF

· I am a student that is not wearing a hat

· And, I roll a 1 or a 2

· THEN

· Change myself into a student wearing a hat


To evaluate the first of the two conditions we need the “Student” agent to see what it is. This can be done using the first condition in the Conditions Palette that says the word “See”, then has a red dot in a white box, and then the “Student” depiction of the “Student” agent. If you click on the red dot in the white box you will see that you can select an arrow to look in one of eight directions around the agent. Selecting the red dot in the middle tells the agent to look at itself. If you click on the depiction image you will see that you can select from any of the depictions in the gallery. It this case it happens to be that this condition was already set just how we need it. With this condition selected you can click the Explain button at the bottom of the Conditions Palette and AgentSheets will explain when this condition is true. To add this Condition to our Rule, just drag it to the Conditions Box in the Behavior window.

For the second part of the Condition (“and, I roll a 1 or a 2”), AgentSheets can’t roll die, but there is a % Chance condition that can be used to introduce randomness into the occurrence of an action. As modelers, we need to figure out how to convert the outcome of the roll of a die into a % chance. If any roll of the die caused us to put on our hat, then we could use 100 as our % chance. The rule in reaction #1 says that two of the six possible outcomes (1 or 2) cause the student to put on their hat, so there is a (100 x 2/6) = 100/3 = 33.33 % chance that the student will put on their hat. 

If both of those two conditions evaluate to “true”, then the action that we want AgentSheets to take is to change this agent’s depiction from a “Student” to a “Student_With_Hat”. The third Action in the Actions Palette is the one we need. Drag the “Change” action to the Action Box in the Behavior window, and make sure that the direction arrow points to “self” and that the depiction to change to is “Student_With_Hat”. The first Rule should now look like the first rule in the image below.
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We won’t worry about setting up rules to reproduce reaction #s 3 and 6,  in which a fixed number of conversions occur on each time step, but we will set up rules that will allow us to simulate the other reactions. Looking at reaction #7 we will need to have two rules for what could happen to a “Student_With_Hat” agent:

· IF

· I am a student wearing a hat

· And, I roll a 1 or a 2

· THEN

· Change myself into a student that is not wearing a hat

· IF

· I am a student wearing a hat

· And, I roll a 3 or a 4

· THEN

· Change myself into a student with hand up

The Behavior window should look like the image above.

The three Rules above should reproduce the student behavior of the most complicated reaction from the Party Hat Chemistry Activity. We can change the values in the % chance boxes to match the different rules for the each reaction. In Step 4 below we will create an easier way to change these rules using Simulation Properties. In order to save the behaviors that you have just created for the “Student” agents, click either the Apply of OK button at the bottom of the Behavior window.

Depending on the values of the % chance conditions for these rules, the model could reach a point where it can’t change any more. For example if we only have a non-zero % chance in the first rule (an irreversible reaction), then as soon as the students without hats are gone, the model will stop changing. We can include rules so that in these cases the model stops running (stops taking more time-steps). 

For the example mentioned:

· IF

· The number of “Student” depictions of the student agent is Zero,

· Students can’t take their hat off

· Students can’t put their hand up

· THEN

· Stop running

If students can raise their hands, we haven’t included a rule for lowering them again, so any students with their hand raised will never convert back. So if we run out of both types of students with their hands down, the model should stop.

· IF

· There are no students without hats

· There are no  students with hats (hands down)

· THEN

· Stop running

Now let’s consider the “Data_Recorder” agent. On each turn this agent needs to tally the number of each type of student. It turns out that one agent can’t really count other agents, but it can send a message to those other agents telling them to add themselves to the count. Keep in mind that we only want to count the number of students of each type that exist on the current time-step (turn), and not a running tally of how many students there have ever been. Therefore, before the “Data_Recorder” sends the message to the students telling them to count themselves, it needs to reset the count for each type of student to zero. We will need to create variables to store the counts, the names “hat_off_count”, “hat_on_count” and “hand_up_count” make it easy to figure out what is being stored and for which type of student. In order for these variable to be set by different agents (“Data_Recorder” and “Student”) you will need to include a “@” symbol at the start of each variable name when setting the value.

Go ahead and click on the “Data_Recorder” tab in the Gallery, and then click the Edit Behavior button. We want the “Data_Recorder” to run a tally on each turn, so we will put our rule in the “While running” method, and we will leave the Conditions Box blank. Use the “Set” action (in the attributes section of the Actions Palette) to set the each of the count variables to zero. Drag the “Set” action to the Action Box and change the word “value” in the upper text box to “@hat_off_count”, then change the bottom textbox to “0” (zero). A quicker way to repeat this action for the other two count variables is to click on any of the red areas on this action in the Behavior window, then click the Duplicate button at the bottom of the Behavior window twice and just edit the count variable names.

The “Broadcast” action under the Messages section of the Actions Palette can be used to send a message. Use the drop-down list in this action to specify the agent to send the message to, and then give the message a name in the text box at the bottom. Don’t forget to edit the description box at the top of each method so that it is easy to see what each block of rules does without having to reconstruct the logic of the rules.
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Since it will be up to the “Student” agents to count themselves, we need to add some rules to the “Student” behaviors. Although we want each agent to count itself on every turn, the rules that do the counting need to be triggered by the message that is broadcast after the “Data_Recorder” resets the count variables. Open the Behavior window for the “Student” agent and click the New Method button at the bottom of the window. The tab at the top left of this method should say On “method_##”. Change the “method_##” text to match the name you gave the message in the “Data_Recorder” Behavior window. 

We will need a rule for each depiction of the “Student” agent that increments (adds one to) the count if the agent is of that type. Use the “See” condition to check which depiction the agent is. Then use the “Set” action to set the value of the count to it’s value + 1. For example “Set @hat_off_count to @hat_off_count + 1”. When you have built the first rule, click in the red area of the rule, beneath the word “Then”, and click the Duplicate button to duplicate the whole rule. Then, change the depiction in the “See” condition, and the count name in the “Set” condition.
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Go ahead and click on the OK button for any open Behavior windows, and close the Conditions Palette and the Actions Palette. 

Step 4 – Add Simulation Properties

Open your worksheet, and from the Tools menu, select Simulation Properties. Drag the Simulation Properties window off to the side of your worksheet so that both can be seen. At the bottom of the worksheet click the step button once (it is to the right of the Run button, and has a yellow symbol on it that looks like this “|>”). Your Simulation Properties window should now have your three count variables listed in it, along with their current tallies of the numbers of students of each type. The reason that these variables have been placed into the Simulation Properties window is that when we included the “@” symbol at the start of their names, we told AgentSheets that these were Simulation Properties, and that is what allows these variables to be seen and used by different agents.

When we entered values for the % chance conditions in the rules that simulate rolling a die, we said that we could use Simulation Properties to change those rules more easily. We will create three new Simulation Properties that represent the number of different outcomes of rolling the die that lead to the student changing state (for example, the rule “if you roll a 1,2 or 3” gives a value of 3). These Simulation Properties will then be used to calculate the % chance for each rule. 

Click the New button at the bottom of the Simulation Properties window, type in “hat_on_rolls”, and click OK. Repeat these steps for “hat_off_rolls” and “hand_up_rolls”. These Simulation Properties will have values between 0 and 6 representing the number of faces of a die. All 6 faces add up to 100%, so each face counts for 100/6% = 16.67%. So if we multiply the value of the simulation property by 16.67, that gives the % chance.

Open the Behavior window for the “Student” agent and replace the expression in the % chance conditions. For example, for the “Student” depiction, the chance should be “@hat_on_rolls*16.67”.  When you have edited all three rules, click the OK button to save and close the behavior window.

Step 5 – Plot the data

Now we would like to plot the count data on a chart that we can view or export for further analysis. To do this, click on one of the count variables in the Simulation Properties window, then click on the Plot button at the bottom of the Simulation Properties window. In the Plot Simulation Property dialog box that opens, click the check-box at the top to plot the property. In the text box on the second line, after the words “in Window”, type a name for the plot window (“Time Course” or “Reaction Progress” or what ever you prefer). It can make your life easier if you copy the name of your plot window (ctrl-C in Windows, command-C on a Mac) so that you can paste it into this box for the other properties that you want to plot. This will prevent misspellings resulting in your data being spread across multiple plot windows with slightly different names. 

You may want to change the maximum of the range for the property. By default it is set to 100, but we only have 24 students on our worksheet. Finally click on the color square near the bottom of the dialog to select a color to use for to plot this property. Click the OK button. 

Repeat this procedure for the other two count variables, making sure that you: 

· Use the correct name for the plot window

· Adjust the maximum of the range in order to avoid empty space on the graph

· Don’t to use the same color for multiple variables

When you are done setting up plotting for all the properties close the Simulation Properties window and click “Yes” in the dialog box asking if you want to save the changes that you have made to the properties. 

Open the Simulation Properties window again and move it to the side of the worksheet. Now click the Step button (next to the Run button near the bottom of the worksheet). The plot window should open on top of the worksheet. Drag the plot window to the side of the worksheet so that the worksheet, plot window and simulation properties can all be seen. You should see the chart shift one time point to the left for each time-step. 

If you right-click in the plot are (ctrl-click on the Mac) a drop-down menu gives you options to rescale the Y-axis, jump to a particular time-step (the time-step you enter is placed at the right end of the X-axis), export your data to excel (as a worksheet with each property in a column), or reset the plot window.

Step 6 – Run your model and explore

Reproduce reactions 1,2,4,5, and 7 in the Party Hat Chemistry Classroom Activity. With your model you can try different rules and see how they affect system behavior. You can see if the effects of randomness are greater or less under various conditions. You can export your data to Excel and create and compare plots of the average behavior of the system using different rules.
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